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Installation Instructions for S&S USB Magneti Marelli® Style VFI  
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IMPORTANT NOTICE:

Statements in this instruction sheet preceded by the following words are of 
special significance.

WARNING

Means there is the possibility of injury to yourself or others.

CAUTION

Means there is the possibility of damage to the part or motorcycle.

NOTE

Other information of particular importance has been placed in italic type.

S&S recommends you take special notice of these items.

WARRANTY:
All S&S parts are guaranteed to the original purchaser to be free of 
manufacturing defects in materials and workmanship for a period of twelve 
(12) months from the date of purchase.  Merchandise that fails to conform to 
these conditions will be repaired or replaced at S&S’s option if the parts are 
returned to us by the purchaser within the 12 month warranty period or within 
10 days thereafter.  
In the event warranty service is required, the original purchaser must call or 
write S&S immediately with the problem.  Some problems can be rectified by 
a telephone call and need no further course of action. 
A part that is suspect of being defective must not be replaced by a Dealer 
without prior authorization from S&S. If it is deemed necessary for S&S to 
make an evaluation to determine whether the part was defective, a return 
authorization number must be obtained from S&S.  The parts must be packaged 
properly so as to not cause further damage and be returned prepaid to S&S 
with a copy of the original invoice of purchase and a detailed letter outlining 
the nature of the problem, how the part was used and the circumstances at 
the time of failure.  If after an evaluation has been made by S&S and the part 
was found to be defective, repair, replacement or refund will be granted.

ADDITIONAL WARRANTY PROVISIONS: 
(1)  S&S shall have no obligation in the event an S&S part is modified by any 
other person or organization.
(2)  S&S shall have no obligation if an S&S part becomes defective in whole or in 
part as a result of improper installation, improper maintenance, improper use, 
abnormal operation, or any other misuse or mistreatment of the S&S part.
(3) S&S shall not be liable for any consequential or incidental damages 
resulting from the failure of an S&S part, the breach of any warranties, the 
failure to deliver, delay in delivery, delivery in non-conforming condition, or 
for any other breach of contract or duty between S&S and a customer.  
(4) S&S parts are designed exclusively for use in Harley-Davidson® and other 
American v-twin motorcycles. S&S shall have no warranty or liability obligation 
if an S&S part is used in any other application.

SAFE INSTALLATION AND OPERATION RULES:

Before installing your new S&S part it is your responsibility to read and follow 
the installation and maintenance procedures in these instructions and follow 
the basic rules below for your personal safety.•• Gasoline is extremely flammable and explosive under certain conditions 

and toxic when breathed.  Do not smoke.  Perform installation in a well 
ventilated area away from open flames or sparks.  •• If motorcycle has been running, wait until engine and exhaust pipes 
have cooled down to avoid getting burned before performing any 
installation steps.•• Before performing any installation steps disconnect battery to eliminate 
potential sparks and inadvertent engagement of starter while working 
on electrical components.  •• Read instructions thoroughly and carefully so all procedures are 
completely understood before performing any installation steps.  
Contact S&S with any questions you may have if any steps are unclear or 
any abnormalities occur during installation or operation of motorcycle 
with a S&S part on it.•• Consult an appropriate service manual for your motorcycle for correct 
disassembly and reassembly procedures for any parts that need to be 
removed to facilitate installation.•• Use good judgment when performing installation and operating 
motorcycle.  Good judgment begins with a clear head.  Don’t let 
alcohol, drugs or fatigue impair your judgment.  Start installation 
when you are fresh.•• Be sure all federal, state and local laws are obeyed with the installation.•• For optimum performance and safety and to minimize potential 
damage to carb or other components, use all mounting hardware that is 
provided and follow all installation instructions.•• Motorcycle exhaust fumes are toxic and poisonous and must not be 
breathed.  Run motorcycle in a well ventilated area where fumes can 
dissipate.

DISCLAIMER:
S&S parts are designed for high performance, closed course, racing 
applications and are intended for the very experienced rider only. The 
installation of S&S parts may void or adversely affect your factory warranty. 
In addition such installation and use may violate certain federal, state, and 
local laws, rules and ordinances as well as other laws when used on motor 
vehicles used on public highways, especially in states where pollution laws 
may apply. Always check federal, state, and local laws before modifying your 
motorcycle. It is the sole and exclusive responsibility of the user to determine 
the suitability of the product for his or her use, and the user shall assume all 
legal, personal injury risk and liability and all other obligations, duties, and 
risks associated therewith.

The words Harley®, Harley-Davidson®, H-D®, Sportster®, Evolution®, and all 
H-D part numbers and model designations are used in reference only. S&S 
Cycle is not associated with Harley-Davidson, Inc.
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NOTE: All brand names, trademarks or registered trademarks mentioned in these instructions are the property of their respective holders and are used in 
a reference capacity only.

S&S® Fuel Injection is not compatible with E85 fuel.  Use of E85 fuel may cause your engine to run poorly and/or damage system 
components.

WARNING

Unrestricted S&S VFI modules and ProTune II software must not be installed or used for tuning of pollution controlled vehicles.

These vehicles have specific calibrations to meet emission regulations. Modifying or installing an unapproved calibration or module is considered 
tampering and is punishable by law.
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INTRODUCTION
The S&S VFI (Variable Fuel Injection) module directly replaces the stock fuel injection module and works with the stock sensors and injectors. This 
Magneti Marelli® Style replacement module works with all 1995 – 2001 EFI touring motorcycles.

This instruction sheet describes the installation of the S&S Magneti Marelli® Style replacement module with a USB computer interface. 

KIT CONTENTS
•	 VFI Module – Also referred to as an ECM (Engine/Electronic Control Module)
•	 USB Port Cover and Hardware Packet

Kit Contents

CAUTION
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ADDITIONAL PARTS REQUIRED
In most instances, the VFI module will be pre-programmed. If the VFI module included in this kit has not been programmed, this will be indicated by 
a label on the VFI module.  

If programming is required, the following items are needed:
•	 A PC with internet connection capable of running the ProTune II software (see minimum requirements in Installation section).
•	 A standard USB-A to 5-pin mini-B cable.

Some applications may require the installation of the Baro Sensor Relocation Kit (P/N:  55-1599).  This kit is required for applications where the 
stock camshaft position sensor (CPS) can no longer be used. Calibrations requiring the installation of this kit will indicate this with the term “MAP 
Synch” in the title and a reference to the Baro Sensor Relocation Kit in the comment field of the calibration.

OPTIONAL ACCESSORIES
All S&S VFI modules are capable of closed-loop fuel control.  Optional Closed Loop Oxygen Sensor kits are available for S&S Magneti Marelli® Style 
and Delphi® Style VFI modules.

The S&S part number for the Closed Loop Oxygen Sensor kit to be used with the VFI module described in this instruction sheet is listed below:
•	 106-2067 – S&S Magneti Marelli® Style VFI Closed Loop Sensor Kit

INSTALLATION

VFI Module Installation

NOTE:  Included in this kit are components used to cover the USB port of the VFI module (o-ring, cover, and 2 screws).  After the module is installed and any 
required work with the ProTune II software is complete, install these components before it is put into service.  This is required to protect the module from 
the elements.

1-	 Disconnect the negative battery cable.
2-	 Refer to the appropriate H-D® service manual to locate and remove the stock module. Save the mounting hardware for reuse.
3-	 Connect the S&S VFI module by inserting the hook on the left side of the 35-position connector into the hinge on the VFI module. Push the 

connector onto the VFI module contacts until the connector fully engages the latch. 
4-	 Install the VFI module in the same location as the stock module using the original mounting hardware.
5-	 Connect the negative battery cable.
6-	 Before starting the motorcycle, power must be cycled to allow the Idle Air Control (stepper) motor to reset. To cycle the power, turn the ignition 

switch on with the run/stop switch in the “run” position then turn the ignition switch off and allow at least 15 seconds for the module to 
completely power down. 

7-	 In most instances, the VFI module will be pre-programmed. If the VFI module included in this kit has not been programmed, this will be 
indicated by a label on the VFI module. If the VFI module has not been programmed, proceed with ProTune II Software Installation followed 
by Installing USB Drivers and Loading a Calibration sections of this instruction sheet. If the VFI module has been programmed, proceed with 
the next step.

8-	 Install the o-ring and port cover on the module using the 2 screws provided (tighten to 2-4 in-lbs.) This is required to protect the VFI module 
from the elements. 

Failure to install the provided USB port cover before use could result in damage to the VFI module not covered by warranty. Do not 
overtighten the retaining screws or you can damage the ECM.  Torque retaining screws to 2-4 in-lbs.

ProTune II Software Installation
The ProTune II Software allows the average performance enthusiast to install existing maps and modify them to optimize the performance of a 
particular engine. Customized maps can also be saved and reloaded allowing a switch between street and drag strip tuning quickly and easily. 
Maps for some of the most common engine and exhaust combinations are included with the installation of ProTune II. In addition, ProTune II is 
a great tool for diagnosing/troubleshooting issues if they arise.

The ProTune II software can be found in the Tech Info section of the S&S Website (www.sscycle.com) or by going to the following address: http://
www.sscycle.com/tech-info/software/

If you are unable to access the internet and need a copy of ProTune II mailed to you, please contact S&S Technical Services at 608-627-TECH 
(8324).

You must have the following minimum PC specifications to install and run ProTune II:
•	 Microsoft® Windows® XP Service Pack 2 or later, Microsoft Windows Vista™, Microsoft Windows 7, 8, or later operating system.
•	 1.0 GHz or faster processor.  Intel® Core™ Duo or faster/equivalent recommended.

CAUTION



4

•	 128Mb System RAM, 256 Mb or more recommended 
•	 200Mb of free hard drive space.
•	 A desktop resolution of at least 1024x768 pixels. Higher desktop resolution is recommended for optimum use.
•	 A modern graphics system with 3D acceleration and 64 MB or greater on board RAM is required.

If you are new to the ProTune II program, you should load it on a computer and familiarize yourself with the screen and the controls before connecting 
to the VFI module.  All required information for the installation is explained below.  For additional information on ProTune II, see the User Manual 
installed with the software.

1- Please use the following steps to locate and install the ProTune II software.
Note: An instructional video covering the installation and initial connection of the ProTune II software with your ECM can also be found by clicking on the 
Instructional Videos section under S&S Media on our web-site:

http://www.sscycle.com/media/instructional-videos/
a- Close all applications other than your internet browser.
b- Go to Tech Info section of the S&S Website (www.sscycle.com) and click on ProTune II VFI Software:

 c- When you arrive at the ProTune II Download page, click on the “Download” button by the current version of ProTune II:

Figure 1 Tech Info Menu

Figure 2 ProTune II Download Screen
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 d- If you are using Internet Explorer, please proceed to Step f. In Google Chrome, a small box will appear in the lower left of the screen that 
shows the progress of the download.  After it is completed, click on the arrow to the right of that box, then click on “Open”

 e- From there, Windows Explorer will open showing the contents of the downloaded file.  Double-click on the “setup” file to proceed with the 
installation of ProTune II as described later.

 f- In Internet Explorer, when you click on the “Download” button the following screen will appear.  Click on the “Save as” button to proceed.
 

Figure 3 File Download and Open in Google Chrome

Figure 4 Double click on the setup file to start in installation process

Figure 5 Internet Explorer Download Screen
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g- Save the downloaded file to your Desktop by clicking to highlight “Desktop” in the left part of the screen and clicking the “Save” button in 
the lower right.

 h- On your Desktop, locate and double click on the downloaded file as shown below, then proceed with double clicking on the “setup” file 
contained within as shown in step e.

i- Depending on your system settings, a screen may appear asking if you want the program to make changes to your computer. Click on "Yes" 
Then, the Pro Tune II Setup Wizard will appear on your screen. From the ProTune II Setup Wizard click Next. 

Figure 6 Saving file to Desktop

Figure 8 ProTune II Setup Wizard Screen

Figure 7 Resulting file downloaded from S&S web-site
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j- The Ready to Install Screen will now appear. Click Install. 

k-	 ProTune II will now install and copy files to your computer. If a Windows Security message appears during device driver installation click 
Install. 

l-	 When the ProTune II installation is completed select Finish to exit the Setup Wizard.

Figure 9 ProTune II Ready to Install Screen

Figure 10  Completing ProTune II Setup
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2-	 See Figure 11. After the installation, the ProTune II program and user manual icons will appear on your desktop.  ProTune II can be opened by 

double-clicking on the program icon.
  

Installing USB Drivers

NOTE: The first time the VFI module is connected to a PC, the USB drivers will need to be installed for ProTune II to communicate with the VFI module. If 
drivers have already been installed, you may skip this section.     

1-	 Close all window applications including ProTune II. 
2-	 Using a standard USB A to 5-pin Mini b cable, connect the mini-USB port on the case of the VFI module to an available USB port on the PC.
3-	 Turn on the ignition switch of the motorcycle and set the run/stop switch to “run”. Do not start the motorcycle at this time.
4-	 The PC will now recognize it has been connected to a VFI module and will start the process for installing the USB drivers. To complete the 

process follow the steps below for the operating system used on your PC.  

USB Driver Installation - Windows® XP
a-	 After a few moments the Found New Hardware Wizard will appear and ask if Windows can connect to the internet to search for driver. 

Select No, not this time and click Next.

Figure 11 ProTune II Program and Manual Icons 

Figure 12 Found New Hardware Wizard
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b-	 Select Install the software automatically (Recommended) from the list of options and click Next.
 

c-	 Windows will locate the correct driver file and copy the required files. Wait for this to complete.
d-	 Depending on your security settings, a Windows Security warning may appear. Click Install to continue.
e-	 When the driver installation is complete click Finish. You can now use ProTune II to communicate with the VFI module.

USB Driver Installation - Windows® Vista and Windows® 7 and 8
a-	 After a few moments Windows will detect the presence of the new device. A small balloon window in the lower-right corner should indicate 

this. Windows should automatically install the USB driver and you can skip to step d.  If this does not occur, proceed with step b.
b-	 When the Found New Hardware dialog box appears, double-click the Locate and install driver software (recommended) option. 

Figure 13

Figure 14

Figure 15 Locate and install driver software (recommended) 
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c-	 Depending on your user account settings a security warning message may appear asking you to confirm the device installation. Allow the 
installation to continue. 

d-	 Depending on your security settings, the Windows Security message shown below may appear. Click Install to continue. 

 e-	 When the installation is complete click Close. You can now use ProTune II to communicate with the VFI module.

Figure 16 Click Install

Figure 17 Click Close 
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Loading a Calibration
In most instances, the VFI module will be pre-programmed. If the module included in this kit has not been programmed, this will be indicated by a 
label on the VFI module. If there is a need to program the VFI module, proceed with the following steps:

1-	 Connect to the VFI module.
a-	 Using a standard USB A to 5-pin Mini b cable, connect the mini-USB port on the case of the VFI module to the USB port on the PC.
b-	 Open ProTune II by double-clicking the ProTune II icon on the desktop. The lower-right corner of the ProTune II window contains a 

communication status box. When there is no ECM (Electronic Control Module referring to the VFI module) communication this box will flash 
between blue and black and alternate between messages No ECM on USB and Checking USB.

 

c-	 Turn the ignition switch of the motorcycle to on and set the run/stop switch to “run”. Do not start the motorcycle at this time.
d-	 The communication status box in the lower-right corner of ProTune II will illuminate green to show that ProTune II is communicating with 

the VFI module. If it does not illuminate green see the Basic Troubleshooting section below.  

 
2-	 Sending a Calibration file to the VFI module.

a-	 From the File menu of ProTune II, select Send all data to ECM… or click on the motorcycle icon in the upper-left corner of the screen.

 
b-	 A window will open showing the list of calibration folders for each type of ECM. Open the folder "USB Port Magneti Marelli® Style ECM" to 

view the available files for this ECM. Select the calibration from the list that most closely matches the vehicle setup and click Open to start 
the calibration download process. Do not switch off power to the ECM at this time.

c-	 After the calibration has loaded a message will appear advising you to cycle power on the ECM for at least 15 seconds. Select OK on the 
message and turn the key off on the motorcycle for at least 15 seconds. 

3-	 The VFI module calibration is now complete. Install the o-ring and port cover on the VFI module using the 2 screws provided. This is required 
to protect the VFI module from the elements. 

Figure 18

Figure 19

Figure 20
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BASIC TROUBLESHOOTING
1-	 Problem:  ProTune II is not communicating with the VFI module.

a-	 Check that the VFI module is powered. The VFI module must be supplied with vehicle power in order to operate. Your motorcycle ignition 
and run/stop switch should be set to the ON and RUN positions.  Make sure that the battery voltage is normal.  Try cycling power to the VFI 
module (switch off the ignition for 15 seconds and then switch on).

b-	 Check that the cable is connected firmly to the VFI module and the PC.
c-	 Try disconnecting and reconnecting the USB connection to the VFI module. This will reset the module connection and allow Windows to 

relocate the device.
d-	 Was the USB driver installed correctly? Please review the Installing USB Drivers section of this instruction sheet.  Additional troubleshooting 

information can be found in the ProTune II Manual installed with the software on your PC.
2-	 Problem: I have the correct calibration loaded into the VFI module for my motorcycle, but it won’t start or idle properly.

a-	 If the motorcycle has a stock throttle body, please review the Stock Throttle Body Setup Procedure section in this instruction sheet.
b-	 If the motorcycle has an S&S or other aftermarket throttle body, please review setup instructions for those components.  Typical S&S 

throttle body closed throttle voltage setting is 0.50 V.  Variation of +/- 0.02 V is typical.
c-	 Perform Test Outputs function using the ProTune II software (see ProTune II manual or help files installed with the software for additional 

information).  Specifically, check to ensure that both injectors and ignition coils are working correctly and installed on the correct cylinder.  
Also verify that the stepper motor (Idle Air Control) is functioning properly.

d-	 Verify that the VFI module is powering down properly. When the VFI module is powering down (ignition on then off) the stepper motor will 
move through a recalibration process and the VFI module will remain in communication with the ProTune II software for approximately 10 
– 15 seconds after the ignition switch is turned off.  If this does not happen, verify components and wiring for the constant or ECM power 
system of the motorcycle.

e-	 If performing the above tasks does not correct the problem, please contact S&S Tech Services.  Be prepared to list details about your 
motorcycle and engine configuration. Model year, displacement, compression ratio, camshaft, intake, and exhaust are typical items needed 
to determine if the calibration is correct.  Also, be prepared to provide the part number or details about the calibration you are using.  This 
information can be found in the Comment Field portion of the calibration.  This is accessed through the View menu of ProTune II.  You may 
also be asked to send your current calibration to S&S via e-mail.

PROTUNE II DIAGNOSTICS
The recommended method for checking the VFI module for Diagnostic Trouble Codes (DTCs) is by using the ProTune II software. DTCs can be read 
and cleared by clicking on the DTCs button found on the upper left of the ProTune II screen when connected to a powered module.
Please, refer to the ProTune II manual or help files for more information on DTCs.

CHECK ENGINE LAMP DIAGNOSTICS

NOTE: The VFI module has a feature where the check engine lamp can be used as a shift light. If your VFI module is configured in this manner, the check 
engine lamp diagnostics function will be disabled.

The procedures to activate and read the check engine lamp are as follows: 
1-	 Turn the ignition switch to the ON position for three seconds (one second pause after the fuel pump stops), and then switch back to the OFF 

position for three seconds.  Repeat this procedure one more time and then turn the ignition to the ON position and wait for eight seconds for 
the check engine lamp to start flashing. 

2-	 The transmission of a code is always preceded by a series of rapid flashes (about 3 per second).  This “intermission” is followed by a 2 second 
pause in which the lamp is off.  The lamp will then flash one or more times to indicate the first digit of the trouble code.  The length of time the 
lamp is illuminated and the length of time in which it is off are each about 1 second in duration.  The number of times the lamp flashes indicated 
the first digit of the trouble code.

3-	 Following the transmission of the first digit, there is another 2 second pause in which the lamp is off.  The lamp will then flash one or more times 
to indicate the second digit of the trouble code.  The number of times the lamp flashes indicates the second digit of the trouble code.

4-	 Following the transmission of the second digit, there is a third 2 second pause in which the lamp is off.  After the pause comes an “intermission”, 
followed by transmission of the next recorded trouble code.  All subsequent codes are sent in the same manner, each separated from the next 
by an “intermission”.  Once all the trouble codes have been sent the data string is repeated.  See Table 1 for a list of the trouble codes supported.

5-	 Turn the Ignition Key switch to OFF.  Wait 10 seconds for the ECU relay to click.  The vehicle can now be started normally.
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STOCK THROTTLE BODY SETUP PROCEDURE
S&S calibrations for use with stock Magneti Marelli® dual bore throttle bodies are setup to use the factory base Throttle Position Sensor (TPS) 
calibration and hot and cold idle screw adjustments. If this module is being installed on a vehicle with a known good throttle body and TPS it is not 
necessary to go through the base TPS setup procedure and you can skip to step 4 below for final idle speed adjustment. If the TPS has been replaced 
or random adjustments made to the idle speed screws, the steps below can be used to get back to the base settings. 

NOTE: Before performing these steps verify there are no intake manifold leaks and all vacuum caps are in place on the throttle body. Also, be sure that 
throttle body components such as linkage arm and bearing are not worn and are in good, operable condition. 

1-	 Base TPS Settings
a-	 Connect the PC to the VFI module and open ProTune II. With the bike turned on, open the Realtime ECM Gauges by selecting “Gauge” from 

the top row of icons in ProTune II. 
b-	 On the Realtime ECM Gauges screen, locate the gauge for “Throttle Voltage” and “Stepper Motor Position”. The “Stepper Motor Position” 

gauge will display the number of steps the stepper motor (or Idle Air Control Motor) is currently holding the plates open and the “Throttle 
Voltage” panel will display the current TPS voltage at that position. 

c-	 Turn the vehicle’s ignition switch to off and observe the Stepper Motor Position. It will close to 0 steps and then open to 96 steps (1995-1998 
models) or 100 steps (1999-2001 models). This is the stepper park position and is the starting point for setting the TPS base settings and 
initial hot and cold idle screws.

d-	 After 15 seconds the VFI module will power down and communication will be lost. At this time, the Idle Air Control Motor (IAC) can be 
disconnected. TPS base adjustments will be made with the IAC motor disconnected and the stepper at its park position.

e-	 Turn the key switch back to run and record the reading from the Throttle Voltage gauge. Remove the cold idle screw and record the TPS 
voltage. Remove the hot idle screw and record the TPS voltage.

f-	 The Throttle Voltage will now show the base TPS voltage. This should read 0.19 to 0.21 volts. If the reading is outside of this range, verify the 
throttle plates are shut by pressing on them gently. If the voltage remains outside of this range, adjust the TPS to correct. After adjustment 
lightly open and close the plates a few times to ensure the TPS voltage will return to the proper setting.

g-	 Proceed to step 2 or 3 below based on your application. 

2-	 Base Hot and Cold Idle Screw Settings for 1340cc (80”) and 1450 (88”)
a-	 Apply a small amount of blue Loctite® to the hot idle screw. Install the screw and adjust until the throttle voltage is showing 0.50 V (1995-

1998 models) or 0.54 V (1999-2001 models) when viewed on the Realtime ECM Gauges screen in ProTune II.
b-	 Lightly open and close throttle to verify setting.
c-	 Apply a small amount of blue Loctite to the cold idle screw. Install the screw and adjust until the throttle voltage is showing 0.61-0.64 V 

(1995-1998 models) or 0.64-.068 V (1999-2001 models).
d-	 Lightly open and close throttle to verify setting.
e-	 Reconnect the plug to the IAC motor.
f- 	 Turn the ignition switch off for at least 15 seconds to allow the  ECM to power down completely.

Check Engine Lamp Flash Code Fault Condition

11 Throttle Position Sensor

12 Barometric Pressure Sensor

14 Engine Temperature Sensor

15 Intake Air Temperature Sensor

16 System Voltage (Battery) High

23 Front Injector

32 Rear Injector

34 Stepper Motor

42 Camshaft Position Sensor

54 EEPROM Error

Table 1
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3-	 Base Hot and Cold Idle Screw Settings for 1550cc (95”)
a-	 Apply a small amount of blue Loctite® to the cold idle screw. Install the screw and adjust until the throttle voltage is showing 0.64-0.68v 

when viewed on the gauge panel in ProTune II.
b-	 Lightly open and close throttle to verify setting.
c-	 Apply a small amount of blue Loctite to the hot idle screw. Install the screw and adjust until the throttle voltage is showing 0.70v
d-	 Lightly open and close throttle to verify setting.
e-	 Reconnect the plug to the IAC motor.
f- 	 Turn the ignition switch off for at least 15 seconds to allow the  ECM to power down completely.

4-	  Idle Speed
Run the motorcycle to evaluate engine idle speed.  First, be sure that the Idle Air Control (IAC) motor is properly reset.  To do so, turn the ignition
switch on with the run/stop switch in the “run” position then turn the ignition switch off and allow at least 15 seconds for the module to completely
power down.  

To properly evaluate engine idle speed, be sure to start with a cool engine and bring the engine up to normal operating temperatures 
(at least 250 deg F).  Be sure the engine idles properly throughout the operating temperature range.

Note: The Idle Air Control (IAC) motor is also referred to as a “Stepper Motor” based on the motor type used.

Engine idle speed is controlled by a stepper motor that adjusts the air flow to the engine during idle conditions. During idle, the stepper opens the 
throttle blades to increase engine speed and/or closes the throttle blades to decrease it.

If issues with the engine idle speed “hanging” high or engine stalling occurs when the engine is idling or returning to idle, the Stepper Motor with
Temperature calibration may need to be adjusted. The following section outlines the procedure for doing this.

5 – Stepper Motor and Idle Speed Calibration
The process of calibrating the stepper motor and idle speed depends on the method used by the ECM to control idle speed.  The S&S ECM uses 
one of two methods to control idle speed: 

A) Active Idle Control – The ECM actively controls the stepper motor to hold a desired or “target” idle speed. 

B) Idle Control Disabled – Idle speed is changed using the throttle body’s adjustment screws and the Stepper Position with Temperature Map
only. In this case, the ECM is not actively trying to control to a “target” idle speed, but adjusts the stepper motor position based on the values in the
Stepper Position with Temperature Map.

Before you proceed with calibrating the stepper motor and adjusting idle speed, you must determine which method the ECM is using.  Most S&S
calibrations, unless otherwise specified, use the first (Active Idle Control).  

To determine which method is used, first check the comment field of the calibration you are using (see “Comment Field…” under the View menu in
ProTune II). If the Comment Field reads “idle control disabled” or similar, then the ECM will use method B. Otherwise, if nothing is mentioned, the
ECM will likely use method A.

To be certain which method is being used, you may also view the “Idle Speed Status” gauge on the ProTune II Realtime ECM Gauges screen while
the engine is running at idle. Select the “Gauge” icon from the top row of icons in Pro Tune II to access the Gauges.

The Idle Speed Status gauge normally appears in the lower, middle portion of the Gauges screen. It will read “Control Active” when using method
A (Active Idle Control) and “Disabled” when using method B (see Figures 21 and 22 below):

Figure 21 Idle Speed Status with Active Idle Control (Method A)

Figure 22 Idle Speed Status with Idle Control Disabled (Method B)
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If the Idle Speed Status Gauge does not appear on your Gauges screen, it may be added by selecting “Add…” from the View menu the top of the
Gauges screen then selecting Idle Speed Status from the list of available gauges.

In some instances, the Idle Speed Status gauge may read “Throttle Too High”.  If this occurs, and the idle speed is too high, this may also be
remedied by lowering the Stepper Position with Temperature Map as described below.

A) Final Idle Speed Adjustment for Calibrations with Active (closed-loop) Idle Control (Method A)

a-	  Allow the motorcycle to cool completely. The engine must be at room temperature before starting this procedure.
b-	 Connect a PC to the ECM, open ProTune II on the PC, turn on the ignition switch, and set the run/stop switch to run. Do not start the motorcycle 

at this time. The bar in the lower right corner of ProTune II should turn green to show it is communicating with the ECM. If communication is 
not established, see the basic troubleshooting section of these instructions.

c- 	 Be sure that ProTune II is operating in “Advanced” mode. Selection between the Advanced and Basic levels of ProTune II can be found in the 
menu item “Select User Level…” under the Options menu of ProTune II.

d- 	 Under the View menu in Pro Tune 2, select “Stepper Position with Temperature Map”. In the window that opens, select the ECM (default) and hit 
OK. This will open the stepper position with engine temperature map from the ECM. This map will show the number of steps the stepper motor 
is open versus the temperature of the engine. Take note of the temperature intervals on the map. 

e- 	 From the top row of icons in ProTune II, select the “Gauge” icon. This will open the gauge panel showing the current engine operation. Identify 
the panels for Engine Temperature and Stepper Position on the gauge panel.

f- 	 Start the engine and allow it to idle. As it warms up, take note of the Stepper Position shown in the gauge panel at each engine temperature 
corresponding to a point on the Stepper Position with Temperature Map up to 250° F engine temperature. 

g- 	 Input the values recorded above into Stepper Position with Temperature Map in ProTune II. For engine temperatures outside of the area tested, 
carry out the trend of the graph to smooth it out.

h- 	 To save the tuned map to the ECM select “Save” from the top row of icons in ProTune II. In the new window that opens select the ECM (default) 
and hit OK. 

i- 	 Turn the ignition switch to off for at least 15 seconds before starting motorcycle.

If you find during the above procedure that the hot idle speed is too fast and the Stepper Position = 0 (fully closed), the hot idle screw may need to
be backed out slightly and the above procedure repeated.

B) Final Idle Speed Adjustment for Calibrations with Idle Control Disabled 
a-	 Connect a PC to the ECM, open ProTune II on the PC, turn on the ignition switch, and set the run/stop switch to run. Do not start the motorcycle 

at this time. The bar in the lower right corner of ProTune II should turn green to show it is communicating with the ECM. If communication is 
not established, see the basic troubleshooting section of these instructions.

b- 	 With the bike turned on, open the Realtime ECM Gauges screen by selecting "Gauge" from the top row of icons in Pro Tune 2. This will open 
the gauge panel showing the current engine operation. Identify the panels for Engine Speed, Engine Temperature, and Stepper Position on the 
gauge panel.

c- 	 Start the motorcycle. As the motorcycle warms up the Stepper Position will slowly close to 0 steps. Once it reaches 0 steps (at about 250° F 
engine temperature) the hot idle screw may be adjusted to achieve the final idle speed (1,000 RPM recommended).

d- 	 Once the hot idle speed is set, shut off the motorcycle, allow it to cool completely, and re-test idle speed.  Some variation in idle speed is 
expected due to changes in oil temperature.

e- 	 Additional adjustments may be made to the Stepper Position with Temperature Map to fine tune idle speed as the bike warms up.  To access 
this map, be sure that ProTune II is operating in “Advanced” mode. Selection between the Advanced and Basic levels of ProTune II can be found 
in the menu item “Select User Level…” under the Options menu of ProTune II.

f- 	 Under the View menu in Pro Tune 2, select “Stepper Position with Temperature Map”. In the window that opens, select the ECM (default) and hit 
OK. This will open the stepper position with engine temperature map from the ECM. 

g- 	 In the Stepper Position with Temperature Map, note there is Stepper Motor Position at different Engine Temperatures.  Increase the values 
to increase the idle speed or decrease them to lower it at the desired engine temperature. Smaller increments of 5 to 10 steps at a time are 
recommended.

h- 	 To save the tuned map to the ECM select “Save” from the top row of icons in ProTune II. In the new window that opens select the ECM (default) 
and hit OK. 

i- 	 Turn the ignition switch to off for at least 15 seconds before starting motorcycle.


